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Chapter 1

Chapter 2

Chapter 3

C HAPTER 1

Introduction

This User Guide is designed to introduce you to Layol, install
the package on your computer and to get you started using it.
You will find several chapters explaining how to make the best
use of Layol, including tutorials. This guide contains the
following chapters:

The chapter you are reading. Discusses the contents of the
Guide, and introduces you to Layol.

This chapter guides you through the install procedure to get a
running copy of Layol and its support programs on your
computer. Although the install process itself is automatic, you
have to make a few basic decisions and enter a few

parameters. This chapter also discusses how to install Layol to
work integrated with a schematic capture program from
OrCAD.

Chapter 3 discusses the use of the Project Manager in
controlling and managing yourPCB design projects. If you are
new to Layol it will get you started using the package. First
we will introduce you to the Project Manager. If you have
integrated OrCAD, we will show how to use Schematic
Diagram data to set up Layol.
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Chapter 4

Chapter S

The chapter contains a short tutorial to design a Layol
component. Finally, the last section will tell you how to use a
macro to store frequently used keystroke sequences under an
[Alt][key] combination. This is not required reading, but
sooner or later you will want to use this feature.

This chapter is a tutorial that takes you through a complete
PCB design cycle. We will use a schematic diagram we have
prepared for you. There are two parts to this tutorial. The
section titled ’Integrated design’ is used if you have integrated
Layol with OrCAD/SDT. We will use OrCAD to prepare the
net- and component lists for Layol. The section titled Stand-
alone design is used if you work with Layol stand-alone,
loading the components and building the netlist yourself.

After the initial preparations of the various files for Layol, a
single section titled Design layout will take you through the
actual design, both for the integrated and for the standalone
mode. Both methods lead to the same correct results. Even if
you use the integrated method initially, you may want to
review the stand-alone tutorial sometime later. It gives you
another view of how Layol handles nets.

Chapter 5 contains a small tutorial emphasizing various routing
functions and creating a netlist. If you work through it you
will get a feeling for the possibilities and aspects of using
Layol’s built-in router to route your design for you. In this
tutorial you will design a simple dual layer PCB.
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Chapter 6

Chapter 7

How to use this
guide

Introduction

This chapter is a discussion and short tutorial for using the
Forward Annotate function, to update your design after
schematic design changes. If you use Layol integrated with a
version of OrCAD/SDT, you can use a built-in function from
the Project Manager, and this is what we will discuss. This
function will preserve the design integrity.

This last chapter is a description and tutorial for the separate
Output Driver program. The outputdriver is a stand alone pro-
gram that can convert Layol output files to industry standard
output files. These files can drive penplotters, photoplotters
and NC drilling equipment to generate documentation, layout
films and PCB’s for a professional end product.

It is not necessary to work through this guide from the first to
the last page before you can start working with Layol. It is
obvious that you should do the installation first. When you are
new to Layol, you should work through Chapter 3. Then you
can jump right in by working through Chapter 4, Working
with Layol. If you get the feel for Layol, you can learn about
specific functions doing the tutorials in Chapters 5, 6 and 7.
You will probably want to periodically review certain entries
in the Reference Guide while you work. Therefor it is a good
idea to at least leaf through the Reference Guide to familiarize
yourself with its organization. That way, you can find your
topics quicker while you work, making the interruptions as
short as possible.
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Layol history

Using the Project Manager is not essential for designing PCB’s
with Layol. However, Project Manager will help you to
maintain a logical flow throughout your work, and also to
control the configuration of the design(s) you work on. If you
use a schematic capture program to 'feed’ Layol, a
customized Project Manager menu system will keep you in
tight control of the design status and help you manage changes
and additions. Note that at install time you can specify to
configure the Project Manager for integration with
OrCAD/SDT III or IV. The Reference Guide contains
extensive information on how to customize Project Manager
for your own environment.

Back in 1984 our PCB production facilities were stretched to
the limits of the accuracy and speed of manual PCB design
methods. We needed automation but could not find a
commercial program that was affordable and had the functions
we required. We wanted to be able to use both millimeter and
inch dimensions, mixed in a single design. We also wanted
general drawing functions to design equipment housings and
fronts. We decided to see how far we could go by designing
our own PCB design package.
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We started with the following design specifications:

® Run under MS-DOS;

® Closely mimicking a manual design with tape and rub-
off symbols;

® Be fast and flexible;

® Have extensive editing functions;

® High internal resolution of 1/1280 inch;

® Use millimeters and inches in a single design;

® At least 7 pen-widths, 7 drill diameters and 15
different pads;

® Manipulation functions to move, rotate, copy
components and parts of a design;

® Output GERBER photoplotter files;

® Directly drive our EXCELLON NC driller.

The first results were very encouraging, and we felt we were
on the right track. The quality of our products was no longer
dependent on ’good’ or ’bad’ days at the tape table. The high
internal database resolution enabled us to accept designs for
any accuracy required. Implementing changes was fast,
without loss of quality.
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Our philosophy

In 1985 the program was so stable and mature that one of our
PCB customers was prepared to pay quite an amount for it to
design his own PCB’s. It then dawned on us that this program
was a very powerful tool for any PCB designer. A small
advertisement in a trade journal brought a few interested
dealers together on a saturday, where we demonstrated the
program - and sold several copies on the spot. We decided on
the name Layol: this is 2/3 of the word layout, and we felt
that once you have Layol, your design is more than half
done...

The most important feature of any PCB for any circuit is its
track layout. Traces should be considered as additional
’components’ (resistors, impedances and capacitances) in the
circuit itself. If signals are weak and/or frequencies are high,
the PCB layout may have a dominant effect on the operation of
a circuit. In many cases, an optimal trace layout in this sense
is different from an autorouter product. These facts led us to
the following philosophy:

"Because the trace layout is an integral part of the
circuit, it should be designed with experience,
knowledge and creativity. A PCB design program
should not override the designer’s creativity with all
kinds of ’auto’ functions with limited results.
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The program should stimulate an interactive design
process of knowledge and experience coupled with PC
power. A high response speed will motivate a
designer to create a quality product and is therefor
indispensable. "

Somewhere in 1988 we really felt the need for a possibility to
use the data from a schematic capture program in Layol.
Layol was a pure drawing program, with a minimum of
overhead and high workspeed. We therefor developed a way to
import and maintain connectivity information, without losing
Layo1’s inherent advantages. The users urged us not to
transform Layol into a pure autorouter, and we have always
honored this. The new version of Layol was called Layol +
(+netlist). The integration with a schematic capture program
offers the following advantages:

® Auto loading of part shapes;
® All electrical connections are always controlled,

without losing the possibility for manual
intervention;

® The ratsnest feature makes it very easy to find an
optimal parts placement;

® The use of colors and rubberbanding makes for
faultless manual routing;

® Real time indication of routings that are completed,
partly completed or in error;

® If required, autorouting using a netlist.
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Once we started selling the basic Layol package, we decided
to do all further development in close cooperation with the
users. This is probably the reason that many packages have
been sold by direct recommendation from enthusiastic users.
We therefor invite you to let us know your comments, remarks
and ideas about Layol. This is an unique opportunity to help
shape the future direction of Layol.

Quality assurance

Throughout this Guide you will find references to ways to
control the design of the PCB you are working on. This cannot
be overemphasized. Very often, last minute changes are
necessary to prototypes and even production runs. If manual
modifications are necessary, they are always very expensive.
We don’t even mention throwing away PCB batches because
of some design error. Changes to prototypes cannot always be
prevented, because not everything can be calculated and
simulated. The layout of the PCB is part of the circuit, and
thus must be tested in hardware. But what can be prevented is
that the layout contains connection and hole pattern errors.

The worst thing you can do is to tape a diagram alongside the
monitor, call up Layol shapes and start routing from the
diagram. If you have available a supported Schematic Capture
Program, use it. Don’t think it will take to long. You will very
quickly find out that if there is no time to do it right the first
time, you will have to make time to do it over again!
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These Schematic Capture programs can help you make sure
that the PCB layout is exactly conforming to the schematic. Of
course, you must make sure that the schematic is correct, but
that must be done anyhow.

If you work with Layol in a standalone mode, more effort is
required, but greater risks for errors are also present. At the
very least, make a list of all components and select the
required shapes from the library in the Appendix to the
Reference Guide. If in doubt, place the actual component over
the printout and verify that it fits the holes. Before you start
routing, make up a netlist. Several ways are discussed in
Chapter 3. Afterwards, check the netlist against the schematic
diagram.

After it all checks out, then start routing. All these measures
also indicate the difference between Quality Assurance and
Quality Control. QA means organizing your work in such a
way that you cannot help but producing quality products. QC
means that you find out which products exhibit failures and
throw them away. That means throwing money away. Layol,
and its integration facilities has all the features to do it right
the first time. Its up to you to use them. And as a reminder,
you can tape an enlarged copy of the following phrase next to
you workplace...
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Fig. 1-1 Murphy’'s Law

PCB production

If you do not do your own PCB production in-house, there are
some considerations you should make when designing your
layout. You should visit your PCB producer to take a look at
the production processes, to get an idea where things could go
wrong if the data or plots you deliver are not optimal. If you
contract out the production, do not do your own plotting.
Deliver the output files (and the Output Driver if necessary) to
the production site. Making the plots is a part of the
production process and is best done by the same people that
use the plots.
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Introduction

Making a prototype from a checkplot and then manually drill it
certainly has its value. But with high volume and/or high value
production runs, do not skimp on an ’official’ prototype
including machine-drilling. Many designers do not take this
trouble, but even if the financial risk for an error lays at the
production site, you can still be faced with a large time delay
when errors pop up. As we indicated above in the section on
quality assurance, try to be absolutely sure of everyrhing
before committing money and resources. We know that under
pressure of time-to-market these principles often do not
survive. But if at all possible, follow them.

Keypresses

Mouse keys

The following conventions are used in this Guide:

Single keypresses are represented by [keyname]. Keyname
may be one or more keys. If [«] has to be added, this will be
explicitly shown. Shift-key combinations are shown as in [1f],
which is identical to [F]. Control-key combinations are shown
as ["F3], which means to hold the control-key down while
pressing function key F3.

Mouse key presses are indicated as ’click WOO’, which means
to press and release the left mouse key. If a pressing of two or
more mouse buttons is indicated, as in MM, the action is
taken only after both keys are released.
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Strings

» item

This means that it is not necessary to press or release the
buttons exactly simultaneously. It is enough if they have been
depressed together at some time before release.

A series of key presses, like a component name or a filename
are indicated as ’enter [filename]’. Unless noted, the string
must be followed by [«]. Quoted strings like ’Net edit’ refer
to a menu selection, a message or other string appearing on
the screen. Also text in a courier font indicate text
displayed on the screen or a command that you must enter.

This references an entry under the name item which contains
additional information related to the current subject. If no
further reference is given, the entry is in the current chapter.
The entry may be shown in the contents; if not, you can look
it up in the index. You may want to review this entry.
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Upgrade

C HAPTER 2

Installing Layo1 |

This chapter guides you through the installation of Layol on
your system. Although the install process itself is automatic,
you have to make a few basic decisions and enter a few
parameters.

Warning!

If you are upgrading from a previous version of Layol, you
must make sure that the drive and directory you will specify to
the installation program are the same as your current system.
If you do not, the install program will not be able to find your
current projects. You can install to a different drive and/or
directory, but then you must move all your current projects
and maybe your custom component libraries, if any, into the
new project and component directories.

Install will overwrite the old component banks with the new
ones. Although the new banks may be larger then the previous
ones, your current components will been retained unchanged.
Therefor, this poses no problems at all, and gives you access
to the latest component models.
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Installing Layol

Integration

However, if you have modified or created components, and
saved them under existing names in the existing component
directories, you must move them to a separate directory before
doing the installation. Again, we stress that you should never
modify components and save them under the same name. This
will create compatibility problems sooner or later. Give them
another name and put them in another directory like
’..\MYPARTSV’

Layol is normally run from the Project Manager. The Project
Manager is a programmable shell for managing your design
and Layol programs. Its use and features are described in the
next chapter and in the Reference Guide. However, before
installing you must decide whether you want Project Manager
to take care of the integration with the Schematic Capture
Program or not. Currently, Layol supports integration with
several versions of the popular OrCAD Schematic Capture
Programs: SDT III versions 3.1 and 3.2, and SDT IV.
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Installing Layol

You can of course use Layol fully in its PCB design role
without Schematic Capture Integration. But integration will
make your designs much easier to maintain, with much less
chance of errors and mistake. You will be able to use Layol’s
built-in error checking facility, and will have the extra
documentation from the schematic diagram.

If you do not want to do the integration now, you can always
do it later, see »Install and Modify. If you would like to
integrate with a not supported Schematic Capture Program, we
suggest that you first install without Schematic Capture, and
get acquainted with Layol. Later you may want to review
Chapter 5 in the Reference Guide on customizing the Project
Manager, and Chapter 2 in the Reference Guide on the Layol
net- and component list file formats.

System configuration

Layol is a complex program that can manipulate large
amounts of data very fast. Although it is fully functional on a
minimum system as described below, the recommended system
will give you faster responses and better display performance.
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Installing Layol

I Minimum system A minimum system consists of:

® IBM (compatible) XT with EGA display adapter;
® 640 Kbyte main memory;

® MS-DOS 3.xx

® EGA monitor

® Harddisk with at least 5 Mbyte free space

® 3 button mouse;

® Laser printer.

Recommended We recommend the following system configuration for optimal
system performance:

® |IBM (compatible) 386 with VGA display adapter;
® | Mbyte main memory;
® 2 Mbyte expanded memory
(EMS 4.0 compatible);
® MS-DOS 5.xx
® VGA monitor (1024 x 768) non-interlaced
® Harddisk 40 Mbyte
® 3 button mouse;
® Laserprinter (for prototype and checkplots);
® Photoplotter if you do your own production.
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Preparations

Installing Layol

First time install

OrCAD/SDT users
only

Before going into the actual details of the installation, there are
some preparations to be make. You also should have decided
on the integration issue. And don’t skip the backup step!

One of the first questions the install program will ask you is
whether you want to do a first-time install, or whether you
want to change the directory structure or the integration with
OrCAD/SDT. Select first-time install if this is the case and
follow the procedure as outlined below. If this is not a first-
time install, continue at the section »Install and Modify below.

Prepare for installation with the following steps:

® Use DISKCOPY to make a copy of the Layol disket-
tes. Store the original diskettes in a safe place.

® Use CHKDSK to make sure there is at least 3 Mbyte
free space on your hard disk before starting the
install procedure.

® If you have decided to integrate Layol with
OrCAD/SDT, check and write down all path and
directory names used by your version of OrCAD.
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Specifying
parameters

Normally, OrCAD/SDT 4 uses the defaults as shown below:

Fig. 2-1 OrCAD/SDT 4 default directory structure

The default OrCAD/SDT III structure will normally be
different. Also, your configuration may differ anyway with
regard to drive letter and/or directory structure. Just write
down your current setup and the OrCAD version you have.

In a moment you will start the installation. Several screens will
appear. Depending on your particular system set up, you might
need to edit an entry or a path. In that case, place the highlight
over the entry to be changed with the cursor keys [-] and [«]
and press [F9]. You can now use the [cursor keys], [Home],
[Backspace], [Ins] and [Del] to edit the entry. If you want to
install to another than the default directory, edit the path. You
can change the default drive by pressing the new drive letter,
as shown at the bottom of the screen.

Follow the directions on the screen. At the bottom of each
screen you will find the keys to press if you want to abort the
installation, to backup a screen, to select another drive to
install to or to start again.
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Drive, directory

Schematic
integration

Project Manager
only

Overwrite confirm

Installing Layol

There will be various messages and questions on the screen.
These will be mostly self-explanatory. You can also read the
next section which gives additional information.

The first install screen will welcome you to the install
program. If you continue, the first question is in which
directory you want to install Layol. You can modify the drive
to install to if necessary. Only for very specific reasons should
you install in an other directory. If you accept the default,
future updates, Project Manager customizing etcetera will be
much easier. But, if you insist, set it to your preference.

Place the highlight on the OrCAD/SDT version of your
preference and press [« ]. The Project Manager will be
automatically set up to provide the links to the Schematic
Diagram of your projects.

Select this choice only when you do an update for the Project
Manager or modify the Schematic Capture integration. If you
want to do that, you should follow the section ’Install and
modify’.

Normally you can set this to Yes. Only if you have custom
libraries you may want to select No. In that case, the program
will ask you if it can overwrite existing files during
installation. If at that time you decline overwrite, that
particular file will not be installed. But in that case it is better
to rename the custom parts and/or move them to a separate
directory and then install all the new files.
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Modify
autoexec.bat

Note that in any case, the Project Manager menu structure and
default user configuration files, if present, (PM.DAT and
USRO00.CFG) will automatically be saved to PM.LA1 and
USERO00.LA1.

If you let the install program modify the autoexec.bat, you will
be able to start the Project Manager from any disk and from
any directory. The modification consists of adding the ’path’ to
the Layol programs. This change will not impact any of your
other programs you might have. If the path is not in
autoexec.bat, you can only start it when you first log on to the
. .\layol\pman)\ directory.

Finally, the install program will present an overview of the
choices you have made. A typical display is shown below:

Fig. 2-2 Typical install configuration

page 2-8 Layol User Guide



Installing Layol

If you want to integrate with OrCAD, continue with the next
section. Otherwise, continue at ’Install stand-alone’ or ’Install
and modify’.

Install and integrate

SDT IV users only

To start the install process, insert the copy of Layol diskette 1
in drive A: and type acinstall[ «]. (Substitute b: if you use
drive b:). Continue the installation until this is finished. Do
not yet start the program, but follow the following section
first.

To enable the Project Manager to start OrCad SDT IV with
the correct display driver, add the following line to your
AUTOEXEC.BAT file. (Review the DOS documentation if
you are not sure how to do this). We assume that you keep the
OrCAD device drivers in c: \orcadesp\drv\. If not, insert
the correct path in the following command line:

set orcaddd=c:\orcadesp\drv\vga640.drv

Reset the computer to activate the new path.

If you see the DOS message: ’out of environment space’, you
must modify the CONFIG.SYS file to increase the
environment space where DOS keeps its data (see the DOS
documentation if you are not sure how to do this).
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Field stuffing

Stuff files

Adding the line:
shell=command.com /p /e:512

to the config.sys file increases the environment space to 512
bytes. If you had to do this, again reset the computer to
activate the new setting.

In the following section we will set up OrCAD to
automatically provide component shape information to Layol.
OrCAD/SDT can automatically associate a Layol component
shape with an SDT parts name. SDT maintains several data
fields with each part used in a schematic diagram. One field
contains the part name. Other fields can be filled in from a
text file. The process is called ’fieldstuffing’, and the text file
to use as input is called a stuff file.

We have included several stuff files with Layol. These contain
the required parts names and corresponding component shapes.
Later, when we start the Project Manager, you will see a
menu page titled Fieldstuffing. The screen will show the files
with the extension .STF. There will also be a user stuffile
option called USER.STF. This can be used to customize the
association of SDT parts with Layol shapes, for instance if
you built your own unique component shapes. Mostly,
however, this will not be necessary. Just select the correct
stuff function from the Project Manager and SDT will do the
rest.
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Stuff fields

Configure OrCAD

SDT III users

Installing Layol

You will have a chance to use this in the tutorial in Chapter 4.
If you do want to make your own stuff file, use the user.stf
option, or copy an existing stuff file to your new one and edit
that file. Stuff files are described in the Reference Guide.

What we will do is tell OrCAD which of the eight data fields
for a part must be filled with the Layol shape name, so that
Layol can find it. Layol will then look up the shape in its
directories or libraries and substitute its own correct part shape
to be used on the PCB design. For this we use the Key Field

option, and set the field number to ’stuff’ to ’1°.
(zie Bz, 2-12 NEL VERCIE Y

To configure OrCAD for Layol, we need to do two things.
First, we will add the LAYO1.LIB to OrCAD. This library
contains the schematic symbols used in the tutorial, described
later in this Guide. For a description of a library file, see the
Reference Guide. The contents of the library (the components)
are also in other libraries, but using LAYO1.LIB insures that
the tutorial illustrations are the same as your screen displays.

Next we will set up the stuff parameters as explained above.
Start the Project Manager by going to the ..\PMAN\ directory
and typing PM[ <]

Using [PgUp] and [PgDn] bring up the menu page titled
OrCAD/SDT Schematic Design Tools. Select *Configure
OrCAD/SDT III’. When the OrCAD screen appears, type
KF12[ <], next press [1]. This sets up the keyfield.
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SDT IV users

Press [Q] to return to OrCAD’s main menu. To install the
library, type LFA1[«<]. Now type LAYO1.LIB[ <¢]. Save the
settings and leave the configuration program by typing QUQ.
This finalizes the configuration of OrCAD/SDT III to work
with Layol. You can skip the next paragraph and continue
with Chapter 3 to familiarize yourself with the Project
manager and Layol.

Using [PgUp] and [PgDn] bring up the menu page titled
OrCAD/SDT Schematic Design Tools. Select *Configure
OrCAD/SDT IV’. When the OrCAD configuration screen
appears, move to the Key fields options. From the field
Create Netlist select Module Value Combine. Enter a ’1’ in
the field, then press [«]. This sets up the keyfield.

To install the library, move the cursor to Library options.
From the window ’Available libraries’ select LAYO1.LIB
and click the Insert button. This finalizes the configuration of
OrCAD/SDT IV to work with Layol. Save the new settings
and exit by pressing [Home][ < ].

If later you want to change the directory structure or the
integration with OrCAD, see »Install and modify. You can
continue with Chapter 3 to familiarize yourself with the
Project Manager and Layol.
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Install stand-alone

To start the install process, insert the copy of Layol diskette 1
in drive A: and type a:install[ <]. (Substitute b: if you use
drive b:). Be sure to select No Schematic Capture
integration as shown below:

No Schematic Capture integration
OrCAD/SDT 3.1x ‘ ’
OrCAD/SDT 3.2

0rCAD/SDT IV

Fig. 2-3 Stand-alone integration

Continue the installation until this is finished. If later you wish
to repeat the installation with Schematic Capture integration,
see the section »Install and modify below.
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Install and modify

Change structure

Change integration

If you have installed Layol previously, but want to change the
directory structure and/or the integration with OrCAD, you
can use the install program to do this. Insert the diskette with
the copy of diskette # 1 in a: and start install as described
above. Answer Yes to the question Update Project
Manager files/menu's only?

You can modify the drive and/or directory where you install
Layol. The install program will save any previous versions of
the Project Manager files it finds to the same name, but with
extension .LA1. But, if you change the drive and/or directory,
Layol may not be able to find your projects anymore. In that
case, you must move the entire . . \proj\ directory under the
. .\layo1l) directory. You can use a utility like Norton
Commander or PC Tools. The process is called ’prune and
graft’.

Install will also ask if you want to integrate Project Manager
with a version of the OrCAD Schematic Capture program. If
you say Yes and enter the required directories, the install
program will set up a new Project Manager structure. If you
have already integrated OrCAD previously, and now say No,
install will dissolve the integration.
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C HAPTER 3

Getting Started

This chapter will get you started using Layol. First we will
introduce you to the Project Manager. If you have integrated
OrCAD, we will show how to use Schematic Diagram data to
set up Layol. Finally, the last section will tell you how to use
a macro to store frequently used keystroke sequences under an
[Alt][key] combination. This is not required reading, but
sooner or later you will want to use this feature.

Project Manager

Although you can run Layol from the DOS command line (see
» Layol structure in the Reference Guide), this is not very
practical. The Project Manager provides an elegant and
efficient command shell for Layol and its utilities and related
functions. This section will therefor assume you use Project
Manager to run Layol.

You start the Project Manager by entering pm from the DOS
command line. Of course, DOS must be able to find the
pm.bat file, which will be in the . . \pman) directory. This
will be no problem if you let the install program add the path
to layol.bat to your autoexec.bat file, or if you did that
yourself.
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Otherwise, you must first change to the ..\pman\ directory
before staring Project Manager. The project Manager opening
screen will be similar to the illustration below.

Project: timebase User: 88

Layol 4.98 Project Manager \LAYDINPROJ\t in;
ayol Graphics Editm | '

Pglp Previous Menu PgDn Next Menu 1! Move Uert ¢+ Move Hor ENTER Select

Fig. 3-1 Project Manager opening screen

At the top of the screen you see the labels for the active pro-
ject name (Project:) and user number (Users).
The display itself is divided in three vertical columns.
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Select menu

Select function/file

Getting Started

® the left column or window contains the menu entries
for the functions you can select;

® the middle column or window shows several files;

® the right column or window is not displayed at the
moment, but would be similar to the middle one.

The bottom line shows the commands to move the highlight
around in the windows.

The display you look at is just one page of several menu
pages. The menu title is shown on the top border of the left
window. [PgUp], [PgDn] and mouse DM will take you to
the other menu pages. Press [PgUp] a few times to sample the
other menu pages. Each page contains several related
command-and functions. On other menu pages other files may
be shown in the second and/or third window. (All this can be
customized; see Project Manager Reference in the Reference
Guide).

Within a menu page, you use the highlight to select a function
or a file. The highlight is moved from window to window by
moving the mouse horizontally, or with [«] or [-].

Within a window, the highlight is moved by moving the mouse
vertically, or with [*] and [¥].
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Confirming a
selection

Last minute info

You can also jump to a selection by entering its first character.
You activate the selected function or file by pressing [<«] or
by clicking mO0. If the highlight is in one of the two
directory windows this will start the built-in text editor with
the selected file loaded. With the highlight in the left window,
selection will execute the function.

There are many instances when you will have to confirm a
selection from a list or menu, to accept a default or to start a
function. This is generally called confirming. Confirming in
Layol can be done in two ways. You can use the keyboard to
press [«]. If you prefer using the mouse, you confirm by
clicking mO0O. There is no preference other than your
personal one. In the remainder of this Guide, we will just say
’Confirm’, and you chose the method that suits you best. Note
that we often mention Top Level. This is the status of the
program when no function is active. It is shown by the small
Layol logo in the far left corner of the status line. You can
always reach Top Level by repeatedly pressing [Esc].

This is a good time to take a minute to read the last minute
info that didn’t make it into the documentation. Move to the
menu page titled Project Manager. Move the highlight to
Layo1 last minute info in the left window and press [«].
This function will load the info file into the built-in editor, so
you can scroll through it using the keys indicated at the bottom
of the display. When you are done, quit with [Alt][x].
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Warning!

Getting Started

If you open a non-text file with the internal text editor, you
will see unreadable text and symbols on the screen. Press
[Alt][x] immediately to exit. If the program asks to save the
file, be sure to answer N. If you inadvertently change and save
a non-text file, Layol (or any other program) may not be able
to use it anymore.

You may exit Project Manager now by selecting the
appropriate function from the left window. When you are new
to Layol, we strongly recommend that you continue with this
chapter, a short introductory tutorial.

Create a component

Getting started

The next section is a tutorial on creating a component shape.
This will introduce you to most of Layol’s principal features
and functions. It will not be anything revolutionary, but we
strongly recommend to follow it before you jump into really
fancy designs and projects. However, if you already know
Layol’s basics, you could skip this and go to Chapter 4, which
guides you through a complete project. The component shape
we will create here is a standard 16 pin DIL.

We assume that you are in the Project Manager. If not, start it
as described in the previous section. The Status Line at the top
of the screen will show a project name, probably NONAME.
First we will clear this name, because we just want to built a
component, not a full project.
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Use [PgUp] or WO and display the menu page titled Project
& User Manager. Select Select project. The cursor will move
to the top left of the screen. Press [Space] to clear the existing
name and then press [ <] to exit the function.

Using [PgUp], [PgDn] or OmO display the menu page
Project Manager, place the highlight on the Layo1l
Graphics Editor entry and press [<]. This will start the
Graphics Editor. Open the Main Menu with [«<] or OOM,
place the highlight on File and press [«] or OOM. Using the
same procedure, select the New Component action from the
file menu.

A window opens where you must specify a component bank
and a component name. We will use ’DIL16’ as component
name. To prevent any confusion with the original components,
we will store DIL16 in a separate bank (really a directory)
named *'TUTBANK’.

As long as no filename has been entered, ’NONAME’ will be
displayed by the program. Use [Backspace] to clear
NONAME. Append to ...\LMC\: TUTBANK\DIL16. Press
[<]. Depending whether the directory TUTBANK exists or
not, you may here a beep and see a message. If that is the
case, press [«] again. You will see Layol’s Graphics Editor
screen again.
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Setting grid

Placing pads

Getting Started

Because the pads in a standard DIL are placed in a .1 inch
grid, we will set Layol to the same raster. Look at the status
line at the top of the screen, to the left of the X. You will see
a grid setting like 1/20. Change that to 1/10 using [F9] or
[F10]. Now press [>] twice, this will display a helpgrid, and
make it also .1 inch.

The last thing to do before starting the design is to snap the
cursor to the .1 inch grid, and we do that by pressing [*]
twice. (Do not try to memorize all these commands at this
point. The idea is to get a feeling for the program. The
Reference Guide contains a full description of all available
commands and functions).

Next we will place the pad pattern for DIL16. Open the Main
menu (press [<«]), select Pad, from the pad menu select
Place. A pad will appear at the cursor. The cursor position in
x and y is shown on the status line. Move the cursor to 0,0.

Drop the pad by clicking mOJO. You may think the pad
disappeared, but when you placed the pad, you hitched another
onto the cursor. The two pads cover each other and are not
visible. You will see it next: Move the cursor one step to the
right (to 1,0) and again click mO0; this places the second
pad. Repeat this six more times until you have a row of eight
pads, .1 inch spaced. The cursor should now be at 7,0.
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We now will place the other row. Position the cursor to 7,-3
and confirm. Place the other seven pads one step to the left of
each other. (Layol has a Repeat Copy feature which lets you
place rows of pads much quicker. This function is explained in
the Reference Guide). The last pad should be at 0,-3. Now
click OOm to exit the pad place function. You should be back
at the Top Level.

Pin numbers Let us check the pin numbers assigned to the pads by Layol.
The pins are numbered in the order they are placed. Press [n]
to display pin numbers. Verify that pins are numbered from 1
through 16 according to the standard ic numbering sequence.
These numbers are small so they do not clutter the design. If
you want, you can click OmO and select a larger zoom scale.
The display should be similar to the one below. Press [n]
again to deactivate the pin number display.

Set temporary By defining a temporary origin, we can continue to use
origin positive coordinates. First position the pad pattern for a good
overview. Place the cursor at 3,2. Click OmO and select
zoom scale 6. Next move the cursor to -1,-4 and press [F6].
The ruler at the status line now displays 0,0.

Drawing the shape Next we will draw a half-circle between the pins 1 and 16, to
mark that end of the shape, as is customary for TTL ic’s.
Place the cursor at 4,3, press [z] or click OBO and select
zoom 8. Open the Main menu (press [Esc] or click OOm).
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Fig. 3-2 Dil-16 pads pattern

From the Draw menu select Circle. The Status Line at the top
of the display will show Draw circle. Now use [F9] or [F10]
to set the drawing grid to 1/20 inch (displayed at the status
line). Position the cursor to 0.5,2.5 and confirm. This sets the
origin of the circle. Press [] once and a box appears,
showing the dimension of the circle. Confirm the size.

Window delete Now we will delete the left half of the circle as follows. From
the submenu: MultiFunc/ Window select Delete. We will
draw a window that encloses the part of the circle to delete.
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Editing the
drawing

Position the cursor to 0,2 and confirm. Next position to 0.5,3.
The window defines the area that will be erased. Confirm.
Answer [Y] to the question Delete ? Half the circle has
been erased now. Return to top level ([Esc]). Press [F5] to
redraw the screen.

Next we will draw the ’box’ part of the shape. From the Draw
menu select Draw. Position the cursor at 0.5,3. This is the
start of the box we will draw. Confirm. Move the cursor to
0.5,4 and again confirm. Continue this with the following
positions until the shape is finished: 8.5,4, 8.5,1, 0.5,1,
0.5,2. Your drawing should now resemble the figure below.
Press [Esc] to return to Top Level.

Now, looking at the drawing, we decide that the shape outline
should actually run inside the pad pattern instead of through
the pads. We will therefor edit the drawing. Set the grid size
to 1/40 (F9 or F10). Position to 0.5,1 on the start of a line
segment. Press all three mouse buttons simultaneously or press
[=] to enter the edit function. Layol will blink the line and
ask if this is the one you want to edit. Press [Y] or confirm.
Position the cursor to 0.5,1.25 and note that the line segment
is moved. Press [-] to step to the next node in the drawing (see
Chapter 3 in the Reference Guide for more information on
nodes). The cursor should now be at 8.5,1. Move this node to
8.5,1.25. Again press [-] to jump to the next node. Move the
node at 8.5,4 to 8.5,3.75, and the node at 0.5,4 to 0.5,3.75.
Return to Top Level and redraw the screen.
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Fig. 3-3 First attempt on DILI6

The last thing we will do is to mark pin 1 of the IC. We do
that by placing a small square around it. Decrease the grid size
to 1/80 inch. From the Draw menu select Box. Position to
0.63,3.63 and confirm. This is one corner of the square to be
drawn. Let’s make this a temporary origin, so we can place
the other corner of the square more easily. Press [F6] to

define a temporary origin. Now position to 0.75,0.75. A
window appears showing the size of the square. Confirm. The
final result should look like the illustration below.

Layol User Guide page 3-11



Getting Started

Fig. 3-4 Final DIL16 component

Area fill  One other function we will exercise is area fill. Suppose that
the shape we just designed is to be used in a sensitive circuit,
and you want to have a ground plane under it. We will
customize the current DIL16 to include this plane on the
copper side.

Define area  First center the design. Place the cursor at 3,-1 and select
zoom step 7. Set the grid to 1/20 inch. To draw the plane,
position the cursor to -1,-4. Make this a temporary origin with
[F6]. Press [1], and select layer 1.
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Fill area

Saving your work

Getting Started

Press [t] to enter the draw mode. This is shown at the left on
the status line. Draw the plane outline by confirming the
following positions from left to right (confirm with mOO):

0,1.5; 9,1.5; 9,0;
10,0; 10,5; 9,5;
9,3.5; 0,3.5; 0,5;
-1,5; -1,0; 0,0;

This should finish the outline. Press [Esc] till you are at the
Top Level.

Now we do the actual filling. The cursor should still be at 0,0.
Press [F] (capital F). Confirm the question. This identifies the
drawn outline as the fill boundary to the program. Next place
the cursor inside the area, for instance at -.5,1. Confirm this
position and the area will be flooded with horizontal lines. If
you see small blank horizontal lines in the area, don’t worry.
They will not show in the output. The result should be similar
to the figure below.

Now clean up : Return to Top Level. Reset the grid size to
1/10 inch and press [*] twice to snap the cursor to the grid.

When you want to save a component, it is good practice to
place the cursor over pin 1. This will set the component’s
origin relative to the cursor to pin 1.
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Fig. 3-5 DIL16 with ground plane

Then, when you later load the component, it will be attached
to the cursor at the same spot. Position the cursor at the center
of pin 1 (the lower left pin). Press [F4] to save your work.
The drawing is saved as .. \TUTBANK\DIL16.

Well, that’s it for this tutorial. You have just created a Layol
component, and in the process executed many important Layol
functions. We suggest that next you tackle the next chapter
which will lead you through a complete PCB design cycle,
using a schematic diagram we have prepared for you.
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Getting Started

Note:

If you have to press the same key-sequence repeatedly, you
may define and save such a sequence as a macro. One useful
macro would be one that presses the keys for you when you
want to load a component into a design. We will create such a
macro here to illustrate the process.

From the File menu select Reset Layol (this is not really
necessary, but this way we start with a clean screen). From
the Options menu select Create Macro. You are asked for the
key-combination for this macro, press [ALT][g]. The macro
will be saved and can be recalled later by pressing the [Alt]
and [g] keys simultaneously.

Mouse control is deactivated during a macro, so you must do
all positioning from the keyboard.

Press [Esc] to open the Main menu. Layol will always save
the last menu selection. That implies you won’t know which
selection is active when you start the macro. You must
therefor synchronize the menu selection by starting from the
top position in each menu. You do this by pressing [Home].
Now you are sure to select the File menu from the Main
menu, regardless of the previous selection.
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® Press [ <] to open the File menu, press [Home] and
select the Load menu;

® Press [Home] and select Component LMC;

® Press [F8].

That is as far we will go, because from this point the actions
depend on the particular component you want to load. End
macro creation by pressing [Alt][F10].

Return to Top Level and redraw the screen. Press [Alt][g] to
try out your macro. You can use this macro every time you
want to load a component.

This ends the chapter ’Getting Started’. You should have a
good feel now how to use Layol. You will probably discover,
that the more you use Layol, the more you appreciate its
many advanced features. Not all of them are covered in this
User Guide. If you work through Chapter 4, Working with
Layol, you get more experience. But you should also from
time to time browse the Reference Guide for specific functions
or functions group. Layol will meet your requirements as you
get more and more experienced and efficient in its use.
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C HAPTER 4

Designing a PCB

If you are new to Layol, we strongly recommend that you
work through the previous chapter, Getting Started, first. That
will give you a working knowledge of several Layol function,
which are used in this chapter. This chapter is a tutorial that
takes you through a complete PCB design cycle. We will use a
schematic diagram we have prepared for you.

There are two entry points in this tutorial. The section titled
’Integrated design’ is used if you have integrated Layol with
OrCAD/SDT. We will use OrCAD to prepare the net- and
component lists for Layol. The section titled ’Standalone
design’ is used if you work with Layol stand-alone, loading
the components and building the netlist yourself.

After the initial preparations of the various files for Layol, a
single section titled Design layout will take you through the
actual design, both for the integrated and for the standalone
mode. Both methods lead to the same correct results. The only
difference is that the integrated method is a bit faster, and
helps you with preventing routing errors (if the schematic
diagram is correct, that is).
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Designing a PCB

Even if you use the integrated method initially, you may want
to review the stand-alone tutorial sometime later. It gives you
another view, and a extra understanding, of how Layol
handles nets. The schematic design we use is shown on the
next page. It is a simple digital timebase circuit, drawn in
OrCAD/SDT 1V.

Integrated design

Start the Project Manager if necessary. Make sure the TIME-
BASE project is shown in the status line. If not, use ’Select
Project’ to correct it. At this point, we have the schematic
diagram in electronic form, but we must generate the files for
Layol to use (netlist, componentlist).

Preparing the files We assume that you have done the section » Configure OrCAD
in Chapter 2, installation. Go to the menu page Schematic
Design Tools (use [PgUp] or [PgDn]). Create the required
files from OrCAD by executing the following function:

Annotate will annotate (number) the components;
Cleanup will remove any redundant objects;
ERC will check for electrical errors (shorts etc).
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Fig. 4-1 Basic timebase circuit
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Verify that there are no errors by opening timebase.err in the
right window (place the highlight over the filename and press
[<1). Before we generate the component list, we must tell
OrCAD to insert the Layol shape names for every part. This
is called fieldstuffing. We already configured OrCAD for it,
see » Configure OrCAD in Chapter 2, Installation.

Stuff fields Go to the menu page Fieldstuff and select function Fieldstuff
all *STF files. You will see the messages from OrCAD scroll
over your screen, when it is extraction information from the
stuff files and inserting it in the parts fields. If you are
curious, you can open a stuff file and see how it is formatted.

Go back to the menu page Schematic Design Tools and select
the function MAKE: Netlist/Create PCB files. This will
create the required files and place them in the Layol timebase
directory. Layol realizes you started a new design. The
Graphics Editor will start and go straight to the Configuration
screen. Before doing any editing, please turn to the section

» Design layout and continue reading there. The next section is
specifically for a design without schematic capture support.

Stand-alone design

In this tutorial we will design a PCB from the schematic
diagram shown in the previous section without a direct link
from the schematic files to Layol.
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Starting the design

Initial configuration

Designing a PCB

You would probably tend to start by loading and placing the
components. Next you would start to manually route each
track, using the schematic diagram as a guide.

However, there is a much better method, which gives you
access to Layol’s netlist checking features, and lets you use
the ratsnest and the router in a controlled design environment.
With this method, you would first create a net- and component
list, and let Layol use this to control the design.

The first thing to do is to set up the directory for Layol to
store all the files you will create in the course of the design.
Start the Project Manager, and use OBO to display the menu
page titled Project & User Manager. Choose Select Project
and at the status line enter "TIMEBASE’. Next select Create
Project Directory, and you will see the project name
TIMEBASE appear in the middle window.

Start the Graphic Editor from the Project Manager menu
page. Because this is a new design, Layol will present the
design configuration screen as shown below so you can set
among other things the PCB dimensions. We will initially set
the PCB dimensions to 160 x 50 millimeters. The y-dimension
is already set at 160 millimeter, so select x-dimension, answer
the units query to input metric and enter 50. Then save the
configuration. (you can always correct the settings later if
necessary, both from this screen, as well as from the Graphics
Editor).
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Fig. 4-2 Design configuration screen

Layol will automatically enter the Graphics Editor and try to
load the design. But there is no component list, and you will
see the message . .\proj\TIMEBASE\PCB\TIME-
BASE.CMP not found. Ignore that for the moment and
press [ <] to continue. The screen will only show the corner
lines, at the PCB boundaries. The PCB is automatically
zoomed to just fill the screen, giving you maximum detail with
a complete view of the design.
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Observe two rulers at the top status line, one displaying inches
and the other millimeters. Using the cursor, verify that the
dimensions indeed are 160 by 50 mm.

Next we will select the component models you need for the
design. Using the Appendix from the Reference Guide, you
would make a list of each component and the shape you wish
to use for it. This should be done carefully, because it will be
the basis for the design. To save time at this tutorial, you can
skip this for once. We will use part of the component list we
have prepared as shown below:

Shape Type Ref
DIL-14 74LS04 Ul
CKER-03 2.4576 MHZ X1
SIL-1X04 4 HEADER JP1
CMKT-02 22NF Cl
SFR25-01 1K R1

Be sure you are at the program’s Top Level (the Layol logo
displayed in the upper left corner), if not repeatedly press
[Esc] until you are. Use [F9] or [F10] to set the drawing grid
to 1/10 inch. Let us load the first part, the 74L.S04. Click
OOm to open the Main menu, select File, and from the File
menu select Load/ Component LMC. A window will open
as shown below.
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Fig. 4-3 File/ load component submenu

Loading components Press [«] to accept the suggested LMC master directory.
From the subsequent display select the ACTIVE component
bank. Yet another window will open, select DIL-14. You will
return to the Graphics Editor screen with a 14 pin DIL shape
attached to the cursor. A window will open requesting the
component type. Enter 74LS04. In the next window (Ref:)
enter Ul. Now move the cursor (with the shape following), to
position 4.0,4.0. Click OOm®. The ic will be placed and the
cursor is released.
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Again open File/ Load/ Component LMC. Backspace over
active\dil-14 and enter passive\ (don’t forget the trailing \).
Press [ <] and from the directory select the CKER-03 shape
for X1. In the Type: and Ref: windows enter the type
(2.45776 MHZ) and the reference (X1). Place this part at
14.0,1.0. Repeat the File/ Load/ Component LMC selection
and when you get the pathname display (which will be the
previous name ..\passive\cker-03) backspace to ..\LMC\ and
press [F8]. Navigate the displayed directories to the
CONNECT directory. Select SIL-1X04, and place it at
19.0,1.0. Enter the type and reference as shown in the table
above. In the same way, enter the other components, placing
them as follows:

® load Cl, from the passive directory, and place at
24.0,1.0;

® load R1, from the passive directory, but before placing
click mOm to rotate the part, then place at
24.0,3.0.

When you are done, the screen should look as the one below.

Place the cursor between the components and press zoom ([z],
make sure caps lock is off!). Select a zoom two steps higher.
The screen will enlarge around the cursor. Note that the
reference PCB in the top left corner shows the PCB outline,
the hole density and a small green cross at the cursor location.
Press [’] several times and note that the display cycles through
displaying the component shape, type and reference.
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Fig. 4-4 Timebase project, few parts loaded

Save .CMP Having entered part of the component list, we will save it. Go
back to the Top Level, open again the File menu, and select
Save. From the submenu select Component list CMP. The
component list is saved. Reopen the File menu, select Quit
and accept Save?. You return to the Project Manager and note
that the right window now shows the file TIMEBASE.CMP.
Place the highlight on this file and press [ <] to load it in the
editor. Compare it with the list above to be sure there are no
errors (the numbers in the last columns are for Layol internal
use). Press [Alt][x] to exit the editor.
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editor

Create net

Designing a PCB

Now that we have successfully entered the component list, the
next thing is to tell Layol the connections to be made. There
are two basic methods to create the netlist. The first one is
from inside the Graphics Editor by pointing with the mouse to
the pins that are part of a particular net. The other method is
to make a netlist with a text editor and loading this netlist in
Layol. We will show both of these methods here.

Start the Graphics Editor again. Layol will automatically load
the TIMEBASE project and show the screen as you left it.
Now open the Main menu, select Options and from the
submenu select Edit Netlist. Layol will go into the net-edit
mode as shown in the top left of the screen. We will create
two nets for the components we have loaded. From the
schematic diagram (see illustration at beginning of this
chapter), you can make out the following nets:

net # 1: X1(2) U1(3) R1(2) C2(1);
net # 2: R1(1) Ul(4) C1(1);

Locate X1. Make sure the component reference is displayed
(use [’]) and zoom to scale 6). Toggle the pin number display
to on with [n]. Place the cursor on pin 2 of X1 and click
mO0. Confirm Create new Net?. Notice that the selected pad
is highlighted. Move the cursor to the next pin in the net (U1
pin 3) and click W00 again. Notice that the created net (now
still only two connections) is highlighted.
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Repeat this for R1 pin 2 and C2 pin 1. To exit from this net,
click OOm. The color of the pads changes to indicate ’part of
a net, but not routed yet’. Do this also for the second net. Exit
the net editor by clicking JCO® once more. If at any time you
make an error and cannot recover, just exit the Graphics
Editor without saving anything and start over again.

Press [z] and go to scale 5. Press [*F4] (Control-F4), and
Layol will show the ratsnest. Press [F5] to redraw the screen
and clear the ratsnest. Open the File menu and select Save/
Netlist NET. Next press [F4] to save the design itself, and
Quit the Graphics Editor.

Using netlist file Normally you will not enter all nets manually from the net
editor. A better way is to prepare a netlist with a text editor.
Place the highlight on the file TIMEBASE.NET in the right
window and press [«<]. You can see that the netlist is just a
text file, and can be edited and created with Layol’s built-in
text editor. But this is not a typing lesson. We have already
prepared a netlist for this project for you to use.

Exit the editor. We will clear the timebase project we have
constructed so far. We will then continue using the net- and
component lists we prepared for you. Go to the menu page
Project & User Manager. Verify that the Timebase project is
selected. Select Remove Project Directory. Affirm the query.
Now all that is left of the painfully constructed Timebase
project is your experience... Next select Create Timebase
Project.
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You will see that all files are again displayed in the right
window. Now continue with the actual layout design at the
section titled Design layout below.

Design layout

If you are at this point not looking at the PCB Configuration I
screen, start the Graphics Editor. Because this is a new design,
the configuration mode is automatically activated (you can

access the configuration menu any time from the Options/Edit
Design CNF menu). The PCB configuration display similar

to the one below will appear:

Initialization Through this menu you can define various parameters like
PCB size, drill diameters and offsets. You can also display the
Pad Table, which contains pad sizes and attributes. We will
skip that for now, though. We will just set the PCB size: leave
the PCB X dimension at 160 mm, and set the Y dimension to
50 mm.

Use the commands and keypresses you have used in Chapter 3
([ <1, confirm etc): Select Board size Y, answer the units
query to use metric input and enter 50. Select *Save Config’ at
the bottom and save the configuration. At this point, you will
enter the Graphics Editor.
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Fig. 4-5 PCB configuration screen

Project loading  Your timebase project will be loaded as follows. The corner
lines are placed. These show the dimensions of the PCB. The
components are placed in the PCB area. Next, the netlist is
loaded and the Ratsnest set up. The ratsnest shows all
connections present in the netlist as direct connections. Note
that the pads that are not used (not in the netlist) have a
different color then the others. At the top of the screen, in the
Status Line, you will see the following information:
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® the selected layer,
® the selected pen,
® the grid size,

® the X,Y coordinates in inches and millimeters.
The display should be similar to the one below

1481 %3188 Y9001 ¥ 78.74 v 22.860 I

TR e

IAYEP1 Layer 1 Pen 1

i

Fig. 4-6 Initial timebase layout

Set grid  Before we edit the PCB we first modify the grid size. Set the
grid to .1 inch ([F9] or [F10]), and snap the cursor to it ([*]).

A .1 inch helpgrid is displayed.

Layol User Guide page 4-15



Designing a PCB

Positioning
components

Manual placing

Select zoom twice (press [zz]) to make sure that the design is
zoomed to just fill the display.

Activate the Blockfunction by pressing [b]. This will be used
to move and/or rotate components. Get block is displayed
at the left of the status line to indicate the current active func-
tion. Put the cursor on pin 1 of Ul, this is the leftmost IC
with coordinates 2,1 (X,Y) on the imperial ruler.

If you have difficulties with precise placement, use [*] to snap
the cursor to the grid. Confirm when you have the cursor
positioned. The component will be highlighted and the
connections to other components are shown. This is very
useful to position components to minimize track lengths and
crossings. Next position the cursor at 8,9 and press OCM, to
place the component.

Now move component U3 from 20,1 to 14,9. It is possible
that the component name is different, but you should use the
indicated position. This component is also hooked at pin 1.

Similarly grab R1 at pin 1 (41,1) and move it to 2,11, but do
not place it yet. Layol always show the connections to the
closest node in the net. Note that R1’s two connections are
crossed. We should rotate this component.
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Press [F1] to verify the mouse buttons for rotate, clear with
[Esc]. (You can also use [F2] to rotate). Rotate twice, note
that the connections do not cross anymore and place at 6,12.

Grab R2 at 44,1 and temporary leave at 2,9. Use rotate to
optimize the connections and place R2 at 6,10.

Return to Top Level. Redraw the screen ([FS]). If your screen
does not correspond to the figure below, exit to the Project
Manager without saving (Select File, Quit). Start Layol
Graphics Editor and work through this chapter again.

Fig. 4-7 Timebase components partly positioned
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Predetermined  You should now know how to position Layol components. To
placing continue with this tutorial, we will let Layol place the other

components. Actually, we performed the placing and recorded
the keystrokes in a macro (» Macros) called [Alt][1]. When
you replay this macro, it will duplicate the keystrokes to place
the remaining components. Press [ALT][1] to start the macro.
You will see the components being moved and placed,
including the real-time rubberbanding. After the macro
finishes, your screen should look as the one below.

Fig. 4-8 Timebase fully positioned

page 4-18 Layol User Guide



Designing a PCB

Adjust PCB  Now we can adjust the corner lines that set the PCB boundary.
dimensions Select Corners from the Draw menu. Position the cursor at

3,0 and confirm. This sets the top left corner. Note that Layer
15 is selected automatically. A window appears when you
move the cursor. Position the cursor at 22,16 and confirm.
The previous corner lines are replaced. The layout is
automatically redrawn, centered and zoomed to fill the screen. I
The design now looks as follows:

LAVE01  La

Fig. 4-9 Final timebase layout
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Save your work

Place text

We recommend that you save your design regularly, to prevent
losing your work because of a power failure or other mishap.
Press [F4] to save the design. You may also activate the Auto
Save option in the User xx/ auto settings submenu. This will
automatically save your design at intervals you can specify.

Next we will place some text in the design. From the Draw
menu select Text. A submenu will open, select Input Text. If
this is the first time that text is used, you may get a request to
select a font. Confirm the request for the default font by
clicking mO0 twice. Enter the following text: Layol.

The text is attached to the cursor and may be moved across the
screen. Pressing [F1] will show the various possibilities for
placing and scaling text. Press [+] or [-] and you will see
Scale: at the status line.

Set scale to 6 using the mouse or the [+] or [-] keys. Rotate
the text 90° and place at 4,3 by confirming.

After placing the text you can immediately enter another
string. This time enter Timebase. Note that the rotation and
scale selected above are kept. Place at 2,2. Return to Top
Level.
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Fig. 4-10 Timebase with text placed

Now on to the actual connections. First let us check the
connections of a specific pad to other pads. Position the cursor
at 3,11 and press [*F2]. Layol will highlight the connections
as contained in the netlist. If you would use the router to route
this net, these are the connections that would be routed. Do it
once more at 18,1.

If you want to check the connections of a specific component
to other components, proceed as follows. Leave the cursor at
18,1 and press [*F3].
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Again, netlist information is used to show the connections.
Finally, pressing [*F4] shows all connections in the design as
a ratsnest. Only connections that would have been routed
would not be shown. After this last action, the display should
look as below:

Fig. 4-11 Timebase ratsnest

Note that the ratsnest displays connections as contained in the
netlist. This may not be the shortest route. However, the
router will route the shortest routes depending on the way you
set it up. Redraw the screen to clear the ratsnest.
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Using the router Layol contains a ’quick and easy’ autorouter combined with
optimum possibilities to manually edit track routes. (See the
section ’Our philosophy’ in Chapter 1). From the Router menu
select Route all. A setup menu will be displayed.

Setup Set the various options as follows (see the Reference Guide for
additional information on the meaning of each of the options).

® Set Grid size to 1/40 using [+] or [-]. This is the
grid that the router will use to make turns and
corners in the traces.

® Set Bus router to No and Lee router to Yes.
The Lee router is better suited for individual traces.

® Set Via router to 0; we will not let the router use
vias to route on different layers.

® Set 45° routing and Pad to pad to Yes. The
last setting will restrict the router to connect only
pads and not traces.

® Set Horizontal to 1 and Vertical to 2. This
specifies the layers for traces in those directions.

® Set Max. Xy error to 32, Max. len error to
16 and Rout len test to 0. These define the
maximum length and strategy for each trace related
to the ratsnest length. See » Router setup, Chapter
3, Reference Guide.

The final setup should be as shown below. Exit the setup menu
with OOm.
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3 R ; s router
Router setup router Yes
Rout windouw e . ia router 0
Route manual routing Yes
Route pad He to pad Yes
Route net Horizontal 1
| Vertical 2
Reroute track .i Hax. xy error 32
Reroute net { Max. len error
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Fig. 4-12 Router setup menu

Route Start the router with BOO. Route all is displayed in the
status line. Note that the color of a pad changes when it has
been routed. When the router stops the top right of the screen
will show End. ... The routed PCB is shown below. Any
connections that had not been routed would also be displayed.
Return to Top Level.

Edit tracks Now, if you had done the routing, you would probably have
routed some traces differently.
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Fig. 4-13 Routed timebase layout

Lets make some adjustments to our own preference. Position
the cursor at 11,1. Set grid size to 1/40 (F9, F10). Pressing
[=] or clicking mmE takes you into the edit mode. A track
segment will blink. Confirm to found?.

We used this edit mode already in the short tutorial in the
previous chapter creating the custom DIL16 shape. We have
now ’hooked’ a track section to the cursor. Moving the cursor
will also pull the track segment to the new position. We can
then use [+] or [-] to step to another segment, and pull that to
another position.
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Optimizing

Erasing tracks

Actually, we step through the datalines in the design

(» Vectors, Chapter 2, Reference Guide). Because the sections
of the track we are working on have been placed con-
secutively, we can ’step’ through the full trace run. Press [-],
the cursor will move to position 8.75,3.25. Move the cursor to
9.5,1.5 and press [-]. Move the cursor to 9.5,13.5 and press [-
1. Move the cursor to 6,14. Return to Top Level. Press [F5] to
redraw the screen.

You will also note some square corners. Position the cursor to
9.5,13.5 .This is such a corner. With the next function we will
change any square corner in the design to a mitered corner.

Set zoom to 7. From the submenu Options/Optimizing
select Sq45 opt 1/40. This will replace all square corners with
45° corners. The ’/40’ part of the function specifies a 1/40
inch grid for the miter, making it small. The result can be seen
in the next figure.

Deleting tracks is just as easy as drawing them. Position the
cursor to 11.5,11.5. Press [Del], then confirm. The track
section will blink, and is then deleted. Another way is to first
hook a track, and then delete it. Position to 14,10. Erase this
track by pressing BOD and confirming. Redraw the screen
(F5).
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Fig. 4-14 Optimize mitered corner

We will now manually reroute the tracks we have just deleted.
From the Router menu select Route manual. Position the
cursor to 14,10 and confirm. Next move the cursor to 11,14
and confirm. The connection between these nodes will be
routed. Press OCJM. This will release the cursor for another
’hook’ action. Similarly, connect 11,15 and 11,10. Press [z]
twice to zoom to full screen display. Return to Top Level.
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i

Fig. 4-15 Manually routed tracks

Defining pads Another thing you might want to change is the shape and/or
size of pads. From the Pad menu select Define.

A window will appear in the upper left corner showing the
various pad definition options. Select Adjust 4. With this
option, you can change all four sides of a pad simultaneously,
so that the shape is preserved.
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An edit window is shown in the upper left screen area
displaying an enlarged image of the pad. The cursor is
changed to a cross-hair and placed on one of the sides of the
pad. This is the ’side-select’” mode. With the Adjust 4 mode it
does not matter at what side the cursor is. The display will
look as shown below.

Fig. 4-16 Pad define mode

The status line displays the pad number: Define Pad 0.7. Next
to it the pad size in millimeters: 1,59 1,59, and the
dimensions from pad-center to each of the sides: 0,79 0.79
0.79 0.79.
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Now confirm. The cursor changes to a small circle ("adjust-
mode’). Use the cursor keys or the mouse to set pad size to
1,39. Press [Esc] to get back to the define submenu. Select
Octagon 1/4. Now all # 0.7 pads in the design are adjusted to
the new dimensions. Return to Top Level.

Defining pen Looking at the design we realize that the ground and power
widths traces could have been a bit thicker. We will therefor change
the penwidth and reroute a net with the new pen. From the
Draw menu select Define. Select pen 2, change penwidth to
0.5 mm. Return to Top Level. The top of the screen will show
pen 2 active.

Rerouting a net Now reroute a power net. From the Router menu select
Reroute net. Place the cursor at 18,1 and confirm. The
selected net will be re-routed with a wider track. Repeat this
for the net at 18,2. The result should look like the layout be-
low. Return to Top Level.

Design rule Layol can also check if there is enough clearance between
checking tracks and pads, and if there are any wrong connections (as
long as a netlist is available). First save your work with F4.
Exit and return to the Project Manager. From the menu page
Project Manager select Design rule check .32 mm. Layol
will now check for .32 mm (1/80 inch) minimum clearance
between elements (all combinations of tracks and pads).
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Fig. 4-17 Final timebase layout

DRC will show its progress on the screen and also write a
report to the file TIMEBASE.DRC. This report can be
viewed by loading it into the editor.

Checkplot Finally satisfied with the design, we will make a checkplot on
our printer. Restart the Graphics Editor if necessary. From the
User xx menu select Printer settings. Select the printer you
want to use. Check all settings for your particular setup. If you
need to change any, place the highlight on it and press [<«].
Save the settings and exit.
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Selecting layers You may print layers separately using the display/hide layer
feature. Press [d] and the following screen or one similar to it
will be displayed.

fictualGroup 1 2 3 4 5 6 7 8 9108 11 12 13 14 15 PO S1 S2 Via
FI TopLopp

Fig. 4-18 Layer select menu

This gives you the option to define up to eight groups of
layers, and select any group for display. This will also affect
the checkplot output (however, if you use the separate Output
Driver for production plots, you can select layers for output
independent of this setting). The possible settings are all
discussed in detail in the Reference Guide.

For now lets set the F4 group to display the pads (0), both
track layers (1 and 2), the text layer (9) and the corner lines
(15). Place the highlight on F4 and press F9. Now enter a
meaningful name for this group. That will make it easier later
to remember the layers in the group. Call this group
CheckPlot.
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Select display Move the highlight to each of the entries on the line and toggle
the checkmarks for layers 0, 1, 2, 9, and 15 to on. Reset all
others. You can toggle the checkmarks with F9. When you are
done, place the highlight on the F8 line and press [«]. You
will return to the Graphics Editor. All layers should be visible.
Now press [d][F4]. Only the previously selected layers are
now visible.

Making a checkplot From the Options menu select Printer checkplot. A submenu
with printoptions will open. Set Plotscale to 2. Set Pads open
centers to Y. Set Plot comment to Y, this will print the
project name, date and time of the plot. Make sure your
printer is loaded and on-line. Select Start output. The print
will start, and you can see the progress at the top left of the
screen. The result should be similar to the plot below.

When the print function has finished, save your design (F4)
and exit to the Project Manager.

This ends this interactive tutorial. The next chapters will go
into more detail on routing.
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C HAPTER 5

Routing functions

This chapter contains a small tutorial emphasizing various
routing functions and creating a netlist. If you work through it
you will get a feeling for the possibilities and aspects of using
Layol’s built-in router to route your design for you. This will
be a simple dual layer PCB. To be clear, lets review some
terms.

In Layol, manual routing means identifying the routes to be
placed and letting the program do the drawing. Manual tracing
means that you actually trace the connections yourself,
inserting nodes wherever you change direction. In the fully
automatic mode, the program will itself select the nets and
draw the traces, if necessary changing layers and inserting vias
on the fly. All this is controlled by the router setup parameters
that you specify before starting the router.

Start the design

Start Project Manager and go to the Project & User Manager
menu page. Activate Select Project and name it TUTORIAL.
Next we must create the directories and default files for Layol
to be used with the project *Tutorial’. Make the required
directories with Create Project.
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Manual loading

Start Layol Graphics Editor. Because you defined a new pro-
ject, you are automatically taken to the Design CNF screen.
Set the PCB size to 90 x 50 mm and save the configuration.

Layol will now try to load the component shapes for
*Tutorial’ into the editor, so that you can position them. But in
this case there isn’t a componentlist (it would have been called
TUTORIAL.CMP). Layol will generate a warning message:
file ..\TUTORIAL\PCB\TUTORIAL.CMP not found.
Ignore this message and continue by pressing [«] or
confirming.

We will manually load the parts for this design. First a
standard 16 pin DIL. Set the grid size to 1/10 inch. Open the
submenu File/ Load. Select: Component LMC. (You could
also use the [Alt][g] macro created in chapter 2). A window
opens with a pathname preset to . . \LMC\. Press [«] and
from the resulting directories display select the ACTIVE
directory.

From this directory select the shape DIL-16. Layol will load
the shape at the cursor position and will open a couple of
windows to request the component attributes. For *Type’ enter
TEST, for ’Reference’ enter IC (the attributes are also shown
at the status line). The DIL-16 is positioned at the cursor
position. Rotate it once and place at position 5,5 by clicking
oOm (use mouse help [F1] to review the rotate command).
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Next we will load a connector with 2 x 17 pins to connect the
board to some external device. We will get the shape for it
from the CONNECT component bank. Position the cursor to
6,2. Again open file/ load/ component LMC, now select
directory CONNECT. Load the shape SIL-2x17. For ’Type’
enter: CONNECT, and for ’Reference’ enter: J. Rotate the
component once and place at 30,2.

We need another DIL-16. Because you have already loaded it
once, it will be in the list of recent used shapes maintained by
Layol. Let us use this then. Click Cm®. From the window
that opens select Directories. Click OmO and you will see
recent accessed files. Select \AACTIVE\DIL-16.LMC, and for
"Type’ specify TEST and for ’Reference’ IC. Rotate and place
at 11,5.

Manual tracing

We will first put down some power traces with pen #2. Press
[p] and select pen 2. Position the cursor at 30,2 and confirm.
This will activate the draw function from the Top Level.
Layol will show the net data at the status line, but because
there is no net defined yet, the netnumber is zero, as is the
number of pins in the net. Position the cursor next at 8,2 and
confirm. Now let us continue at the other layer.
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Fig. 5-1 Tutorial PCB, shapes placed

Check the status line for the current layer, probably 1. Press
[F8] to change the layer and verify at the status line. Position
the cursor at 8,5. Press [Esc] to exit from the Draw function.
Note that although the traces look connected, they are not
because they are on separate layers. We will fix that later.

Start again at position 14,5 . Confirm and go to 14,2 and press
[Esc]. We will place a via here to connect the two traces.
Zoom in to level 7 to get a clear view. Press [F2] to place the
via at the current position (14.0,2.0). Place another via at
position 8.0,2.0. Press [z] twice to zoom the design to fit the
display.
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Manual routing

Now let us use the services of Layol’s built-in router. We will
identify a connection to be made, and let the router do the
actual tracing. We call that manual routing; but in the
literature it is sometimes called semi-automatic routing as well.
From the Router menu select Router setup. Set the router
options as shown in the illustration below (use [+] or [-]).

Layole 499 G ALAYOINPROINTUTORIALAPCBNTUTORIAL.

Pad MultiFunc Grid size
: S : Bus router
Lee router
.| Rout uindou : Via router
i Route manual 45° routing
@ Route pad L Pad to pad
§ Route net i § Horizontal
| Route all - i Uertical
Reroute track i Max. xy error
Reroute net L Max. len errorEZR
; Rout_len_test

Fig. 5-2 Router setup for manual routing
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Manually route
trace

Delete traces

Exit the setup menu ([Esc]) and select Route manual from the
Router menu. This is now shown at the status line. Confirm
position 30,15 and move to position 11,12. Layol will
maintain a ratsnest line while you move the cursor. Confirm
The track will be automatically routed between the two
specified points. Because you allowed a via in the setup,
Layol will use that to switch layers. A via will be
automatically inserted at 11,15. Release the cursor by pressing
[Esc] or clicking OOm. Using the same method, route a track
from 11,15 to 5,12 and return to the Top Level.

Move the connector a little closer in, using the Block function.
Position the cursor at 30,2. Press [b] to activate the block
mode. Confirm to *hook’ the connector and attach it to the
cursor. The shape’s color will change, and ratsnest connections
will be shown. Move to 20,2 and press O COM. Redraw the
screen.

Before trying yet another routing method, lets first delete some
traces. We will do that by drawing a window and deleting all
enclosed objects. From the Multifunc/ Window submenu select
Delete. Confirm position 2,1, this is one corner of the
window. Move the cursor to 22,16 and confirm to set the
window size. Reply affirmative to: *Delete ?°. All tracks
inside the window will be erased. (We could also have delete
the whole pattern at once using ’Delete layer’; see the
Reference Guide). Return to top level and redraw the screen.
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Full automatic routing is only possible if a netlist is available
for the current design. You can generate a netlist easily using
the Net-editor. We will create a short netlist and tell Layol to
route the connections contained in it. You may also want to
review the section titled *Standalone design’ in Chapter 4 on
creating and using a netlist.

Warning! To maintain design integrity you cannot edit a netlist
generated from a schematic capture program. If you try to call
up the net editor in such a case, the message: Project Man-
ager active! will be displayed. To insure design integrity you I
should make changes in the connections or the components to
the Schematic Diagram only, and use the Forward Annotate
function to transfer the changes to Layol. Forward Annotate
will be described in the next chapter.

Create netlist Now we will generate a netlist. From Options menu select
Edit netlist. Confirm 20,2. Because no net is active, and the
clicked node is not in any net, Layol assumes that you want to
start a new net. Answer [Y] to: Create new net? The
selected node is highlighted. Also confirm 14,5 and 8,5. These
three nodes are now part of a net (see also the status line).
They are all highlighted. Release the cursor using JJm. Now
press [Esc] and answer Yes to Quit Net Editor. Go to
the Top Level and press [*F4] to check the ratsnest.
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In the same manner as above, again enter the Netlist Editor
and define the following four additional nets (release the
cursor with OJCJm after each net):

® net # 2: 20,15 + 11,12 + 5,12.

® net # 3: 20,6 + 11,6 + 5,6.

® net # 4: 21,6 + 14,6 + 8,6.

® net # 5: 20,10 + 14,10 + 8,8 + 5,11.

Quit the net editor and return to Top Level.

‘Ratsnest for created nets

Fig=' 5
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Manually route net With manual routing of nets, we have full control of the order
and way the connections are traced. We identify the nodes to
be connected, and Layol merely does the drawing. We will
show that here. Press [p] and select pen 1. From the Router
menu select Route manual. Confirm 20,2. This is the first
node from net # 1. Next confirm 14,5 and 8,5. In each case,
the traces are drawn. Because the routing of 45° corners is
disabled (see router setup above) Layol uses square corners.

Error detection Lets now try another net, making a deliberate error. First set
the router setup parameters as shown below, which among
other things confines all traces to layer 1 and enables mitered
corners.

Confirm the following nodes: 20,6 11,6 and 8,6. Layol
realizes that the first two are from net # 3, but the last one is
from net # 4. Now if you want you can connect two nets. But
Layol warns you with the question: Route to other
net? Answer No and confirm §,6 which is correct (see net #
3 above). Note also that now the track corners are 45°.
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T iEESEEEgE Bus router Yes

T ' : Lee router Yes

¥ Rout windou ! Uia router 0

i Route manual i 45° routing Yes |
Route pad Pad to pad Yes
Route net : + Horizontal 1
Route all ! | ot i 1]
Reroute track B ; . XYy error 32
Reroute net » . len error 32

= Reroute all = Rout_len_test 0

Fig. 5-4 Router setup single sided

Release the cursor and return to Top Level. Display the
ratsnest and verify that the routed nets are considered
completed. Their nodes also have a different color. This
method of routing and the support that the program gives to it
is very powerful if you need full control over the layout, yet
maintain full control over the design. Now is a good time to
save your work (F4). The result should be as shown below.
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- Y BB X 20.32 Y 20.32n

Fig. 5-5 Two nets routed

Full automatic routing

We will let Layol autoroute the remaining nets. We will keep
the previous router setup, because it will be possible to route
everything on just one layer (see router setup illustration
above). This is the normal setting if you are building a single
sided PCB. From the Router menu select Route all. The
remaining connections are routed. At the end, the status line
indicates 100% completion. The resulting layout is shown
below. |
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Save the netlist by selecting Netlist NET from the File/
Save submenu. Quit the Graphics Editor. If you wish you can
view the generated netlist from the Project Manager’s editor.

This brings us to the end of this tutorial. When you have
worked through the previous tutorials as well, you should now
be ready to tackle more involved designs. Keep your
Reference Guide handy. There are many more functions you
will want to use; you will find that when you look up the
function listing, that there is something for every situation.

Fig. 5-6 Final tutorial PCB layout
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Router tips

If you must route a complex PCB, take some time before you
start to decide on the strategy to use. First determine whether
you really need a double sided PCB. Single sided ones are

much cheaper. You can do a quick test by turning the

autorouter loose on the design. Even if it doesn’t finish, you

will have an idea whether a single sided PCB is feasible or I
not. Next determine if there are any nets (for instance power
supply lines or high frequency lines) that are critical regarding
their length and/or routing. Route these first by hand or semi-
automatically.

Next you can use the router for the other nets. If you make a
double sided PCB, use one layer for vertical and another for
horizontal routes. Begin with no via’s and small values for the
length error parameters (see » Router setup in Chapter 3,
Reference Guide). Then allow one via, and relax the error
parameters. Check the layout between steps, because very
often you can clear a path with just one or two manual
changes.
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Note that when you allow two via’s, the router will tend place
a via every time it changes from a horizontal to a vertical
direction. A track going north, then east, then south will have
two via’s, and use two layers, even if it could have been
routed all on one layer. This is not a shortcoming of the
router, but part of the algorithm that assumes that you only
allow vias if you want the router to make use of it as part of
your strategy to design the layout. This consequent use of
separate layers for horizontal and vertical traces will ensure a
maximum completion rate for complex designs.

page 5-14 Layol User Guide



C HAPTER 6

Forward annotate

This chapter concerns itself with changing a design as a result
of changes in the Schematic Diagram. If you use Layol
integrated with a version of OrCAD/SDT, you can use a built-
in function from the Project Manager, and this is what we will
discuss. This function will preserve the design integrity. If you
are using Layol stand-alone, you will have to do it manually.
This is a little more involved. Connection changes can be
made with the net editor (do not forget to save the modified
net before leaving the Graphics Editor). You can remove
components by deleting them, and add new ones by loading
them. In both cases you have to adjust the netlist. The
component list must also be saved separately.

Update the schematic

Start Project Manager and select the Timebase project. Select
Draft from the Schematic Design Tools menu page. Place a
capacitor (capacitor pol) from VCC to GND, to the right of
C2. (don’t forget the junctions!). The Schematic Diagram
should now look similar to the illustration at the next page.
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In the next section, use capitals for the shape name. Edit the
new part’s parameters as follows (consult the manual for
OrCAD/SDT if necessary):

® part reference (Reference): cs |
® part value (Part Value): 100/ Uf) 5
® shape name (1st Part Field): CE03-06A

Exit the schematic capture program with QUA.

Update all files

Now we will have to update the net- and component list files.
This is simple. From the menu page Schematic Design Tools
select the function Layol Forward Annotate. You will see a
lot of activity while the Project Manager first makes
OrCAD/SDT generate the new net and component files, and
then transfers the changes to Layol.
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Error log Note that if there are any errors encountered, Layol will save
these in a file with the project name and the extension .ERR.
The changes will not be implemented. But, if there are no
errors, the Layol Graphics Editor will start up. The new
component is positioned in the upper left corner. The ratsnest
will show the connection to the new component.

Fig. 6-2 Timebase layout, C5 loaded

We will place this capacitor at a free area on the PCB.
Position the cursor at 18,10. We will snap the component to
this position by pressing [u]. This will open a window where
you can specify the component to snap. Enter CS.
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The capacitor moves to the cursor. Rotate it three times (use
mousehelp, F1, if you are not sure how to do this). Place it by
clicking JOM. Press [F5] to clear the screen.

Note that C5’s pads have a different color, indicating that they
still have to be connected to their nets. Because these are
power traces we will again use a heavier trace. Open the pen
menu by pressing [p] and select pen 2. Select Route all from
the Router menu to connect the component to the existing
layout. The final result is shown below. Save your work, quit
the Graphics Editor and return to Project Manager.

4.98  Autorouting 46

Fig. 6-3 Updated timebase PCB
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Note 1:

Note 2:

Note 3:

A change in component shape cannot be implemented with
Forward Annotate because it is not an electrical change. You
can change a shape by hooking the old component using the
Block function and then replace the shape with [*F3].

Never change the references in your schematic diagram. Do

~ not use the Annotate function from OrCAD if you have added

a part, but rather set the reference for the new part manually.
Part references are Layol’s means to keep the design intact. If
you absolutely have to make changes, do as follows:

® Make a *WAS-IS’ file as described in the OrCAD
documentation;

® Edit the .NET file in Layol’s PCB directory for the
project so that it corresponds to the WAS-IS file;

® Run OrCAD’s BACKANNO function with the WAS-
IS file to update the schematic diagram.

OrCAD/SDT IV has a feature called incremental annotation.
If your schematic change consists of added components only,
you can use incremental annotate. OrCAD will number the
new components but will not touch the references of the
existing components. See your OrCAD/SDT IV Reference
Manual for this feature.
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Output Driver

The outputdriver is a stand alone program that can convert
Layol output files to industry standard output files. These files
can drive penplotters, photoplotters and NC drilling equipment
to generate documentation, layout films and PCB’s for a
professional end product.

The Output Driver program is not copy protected and may be
copied and installed wherever it improves the production
process. However, the copyright to the program is retained by
Peter Baas.

Limited license Peter Baas hereby grants you a limited license to duplicate and
distribute the Output Driver program, on the condition that it
will not in any way be modified or altered. You also may not
request or receive any payment or other reimbursement from
third parties for the use or distribution of this program.
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The program contains 20 configuration pages that can be
selected with [PgUp] and [PgDn] or through a selection
window. Each configuration page contains all the data and
parameters for a complete output job, including the device
configuration and the data to be output. All configuration
parameters are saved on disk.

We recommend that you use a consistent system for allocating
the configuration pages. For example:

® Pages 1 - 10: testplots;

® Pages 11 - 18: photoplots;
® Pages 19 - 20: drill files.

IOvervieW

The Output Driver has the following features:

® Menu driven;

® Selection of up to 40 recently used files;

® Most options can be directly verified and adjusted;
® Graphical preview of pads and layers;

® Extensive scaling options;

® Image move, rotate and mirror;

® Optional pad center holes to facilitate drilling;

® Automatic or manual pen change;
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® Specification of any pen width and/or speed;

® Adjustable ’blackscale’ (fill step) to generate normal or
extra black plots;

® Scaling of all pads and pens for mask generation
purposes;

® Drill program: a ’tool’ selection for every drill;

® Via’s, pads, SMD pads can be assigned a unique
‘pen’;

® 15 layers can be selected separately, each with a diffe-
rent pen;

® An extra pen selection for drawing a grid, the
filename and a date/time stamp;

® Automatic flash/draw selection for GERBER output;

® Qutput directly to device or to disk.

Inputs and devices

There are many different files and datasets that can be
selected. Also, the number of output devices and output
destinations is large. That gives a very wide range of
combinations for every user. You should therefor plan the
output process carefully. But if you contract out the PCB
production, leave the output plotting to the contractor. (See
also »Quality Assurance in Chapter 1).
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Input files In the interest of maintaining upwards compatibly, the Output
Driver accepts also output files from previous versions of
Layol. The Output Driver can handle any Layol file with
extension .BNK, .LAY, .LMC, .LML (with or without its
.CNF) or .PLY (with its .CNF).

Output devices Several output standards are supported for maximum

flexibility:
e DMPL Houston Instruments plotters;.
e HPGL Hewlett Packard compatible plotters;
® GERBER For photoplotters and some drilling

equipment;
® EXCELLON  Drilling equipment (US);
o SIEB&MEYER Drilling equipment (European);
® POSTSCRIPT PostScript compatible printers.

A DXEF driver is planned for a future release. Note that
prototype quality output can be generated directly from the
Layol Graphics Editor to HP LaserJet and Epson compatible
printers (see Chapter 4 and the Reference Guide).

Delivery by modem A Layol file is quite compact and contains all information for
producing a PCB and supporting documentation. The output
files may be 50 to 200 times larger.
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If you want to deliver your files to a production site by
modem, you should send the original Layol files and have the
output files generated at the production facility. You are
allowed to copy and install the output driver program at the
production site, see the limited license statement at the
beginning of this chapter.

Setting up an output job

All parameters for a particular job are associated with a
configuration page. To set up a page for a job, there are two
basic data sets to be defined: the output device and the data to
be output.

Select device To configure a device for a job, you select Device from the
Main window of the Output menu screen, and select a device.
When you press [F9], a window will open to let you edit the
device specific parameters. You can find more info on this
data in the Reference Guide, Chapter 7.

Layol User Guide page 7-5



Output Driver

Select data  You must of course also specify the data you want to output.
There are currently three data sets you can select from the
Main window from the Output screen:

® Output selected pad-groups and layers,
® Qutput the drill hole pattern,
® Qutput a drill file for NC drilling equipment.

After you have selected the data set, you can further refine the
output and its appearance by editing the data in other windcws
of the Output screen.

The following section will discuss a typical case using the
previously designed TIMEBASE PCB.

Output plot

Let’s assume you have an HPGL compatible penplotter at
parallel port LPT1. You wish to plot layer 1 (solder side),
layer 2 (component side), layer 8 (part shapes) and layer 9
(text) as a stuffing guide for the timebase project.

Enter the Project manager and be sure that the Timebase
project is selected. From the Project Manager menupage
Project Manager select Layol Output Driver. You will be
taken to the Output screen as shown below.
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i
evice Conf.

Fig. 7-1 Output Driver Output screen

From this screen select Config page 1/20 and choose a page
number, lets say page 5. Go to the second line in the Main
menu, which default shows HPGL. Press [F9], and you will
enter the Device configuration screen. From the window titled
Device basics select Driver type, from the window that opens
select HPGL. Next select the Device name entry and enter a
meaningful name for later reference, like Stuffguide. This
name is only for reference purposes and has no effect on the
output. Save and exit this menu and return to the Qutput

menu.
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File and data set

Pen select

Next we will set the remaining entries in the two top windows.
Select the Plot Layers entry from the Main menu. You will
see a window with three choices. Select the choice Plot layers.
Now open the Input entry in the Input/Output window (you
can use F3 as indicated). From the File type window select
Design CNF PLY. This tells the output driver that the input is
a full Layol design complete with configuration file.

Note that you can also output single components (.LMC) and
other files. These are explained in the Reference Guide. Next
a window will open requesting the name of the design. Press
[F8] and select the appropriate directories to navigate to the
..\proj\timebase\pcb\timebase.ply file. Set the
Output entry to Iptl: if necessary (use the highlight or F6).

Now we will select a pen for the selected layers to be plotted.
Move the highlight to the lower left window titled Pads +
Layerdata + pen selection. Note that the number of data
items present on each layer is shown. Select plotter pen # 1
for the following entries:

® Pads 1..15,
® Layers 1,2,8 and 9,
® Filename and Date.

If any other layers seem to contain data (layer 15), select pen
0 for them, effectively excluding them from being plotted.
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General data From the lower right' window titled General set and modify as
necessary for your particular plotter setup:

® Plotscale: 2.00;
® X and Y offset: 0;

® Rotate, Mirror: N;

® Auto tool change: Y;

® Fill step: 100;
® Size Corr: 0.00;
® Center: 0.5.

Fill step Fill step specifies the overlap of the lines drawn. At 100%,
there is no overlap. If you want to know more of the other
parameters, see the relevant entries in the Reference Guide.
Now that al parameters have been set, press [FS] (or select
Graphics from the main window) for a graphical preview of
the output. This gives you a last check point before starting an
output process, which can be very time consuming with some
devices. The final setup is also shown below.

Switch the plotter on-line and verify that pens and medium are
loaded. Press [F4] to start the output. You can stop the output
anytime by pressing [<].
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— Layol 4.90 —— upu ———————————— Uer-
T T L L L
— Input <F3>  Output — -
it G:\LAYOINPROJNTIREBASENPCBNTIMERASE PLY

— <F9> Device Conf.— —

Fig. 7-2 Final Output Driver setup

Note 1: If no output is generated, check all cabling and connections.
Press [Esc] to cancel the output.

Note 2: For GERBER files, use round pads if possible. Such files are
more compact and are processed much quicker.
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File select 7-8
graphical preview 7-9
prototype quality 7-4
Select data 7-6
select pen 7-8

start 7-9

output driver

configuration pages 7-2
data sets 7-6

layol files 7-4

limited license 7-1
output formats 7-4
Output menu 7-5
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P
pad
color 4-12
connections 4-21
edit 4-29
edit, side select 4-29
gerber, round 7-10
number 4-29
open centers 4-33
shape 4-28
size 4-28, 4-29
table 4-13
Pads
covering 3-7
Path
to pm.bat 3-1
PCB dimension
editing 4-5
pen
change width 4-30
Select 4-30
Penwidth 4-30
Pin numbers

Plot comment 4-33
Plotscale 4-33
Printer

checkplot 4-33

checkplot, start output 4-33

Printer settings 4-31
Project
create 5-1
Create directory 4-5
loading 4-14
remove 4-12
Select 4-5
Project manager
customizing 3-3
display windows 3-2
last minute info 3-4
menu pages 3-3
navigating menu 3-3
Prototypes changes 1-8

Q

quality assurance
considerations 1-10

assigning 3-8 integrated environment 1-8
display 3-8 machine prototype 1-11
Place stand-alone environment 1-9

via 5-4
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R

Ratsnest 4-14
component 4-16, 4-21
full 4-22

Recent accessed files 5-3

reference
conventions 1-12

Reference PCB 4-9

References
component, change 6-6

Remove
project 4-12

Reset
layol 3-15

Rotate 4-17

Route
all 5-11
manual 5-5
quick test 5-13
strategy 5-13
to other net 5-9
vertical, horizontal 5-13

router
Setup 4-23
single sided, setup 5-11
strategy 4-23

Rubberbanding

Index

real-time 4-18

Ruler 4-7

S

save
Auto 4-20
component list 4-10
design 4-20
design configuration 4-13
netlist 5-12
origin for, 3-13
Select
component shapes 4-7
component directory 5-2
layer 3-12
pen 4-30
project 3-6, 4-5
Semi-automatic routing 5-5
set up
Module value fields 2-12
Stuff fields 2-11
settings
Printer 4-31
Setup
router 4-23
shapes
select 4-7
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Snap

component 6-4

cursor 3-7
Status line 4-14
Strategy

routing 5-13
Strings

entering 1-12
Stuff fields

set up 2-11
Stuff files 2-10
Stuffing guide 7-6

T

Text

draw 4-20

font 4-20

input 4-20

placing 4-20

Rotate 4-20

scaling 4-20
Timebase circuit 4-2
Top Level 3-4
Trace

delete 5-6

error 5-9

square corners 5-9

Tracing
manual 5-3
Track
delete 4-26
edit 4-25

U

update
drive/ directory, install 2-14
integration, install 2-14
layol files 6-3
project manager 2-14
Use
Reference guide 1-3
stuff files 2-10
user guide 1-3
User
menu 4-31

\%

via
algorithm 5-14
allow, router 5-13
auto insert 5-6
place 5-4

Via router 4-23
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W

WAS-IS file 6-6
Window
delete 3-9, 5-6

Z
Zoom 3-8

[+] 4-20, 4-23, 4-25, 5-5

[-] 3-10, 4-20, 4-23, 4-25, 4-26, 5-5
[*] 3-7, 3-13, 4-15, 4-16

[*F2] 4-21

[*F3] 1-11, 4-21, 6-6

[*F4] 4-22, 5-7

[=] 3-10, 4-25

[>] 3-7

[b] 4-16, 5-6

[Del] 2-6, 4-26

[d] 4-32

[F10] 3-7, 3-9, 4-7, 4-15

[F1] 4-17, 4-20, 5-2

[F2] 4-17, 5-4

[F4] 3-14, 4-12, 4-20, 7-9

[F5] 3-10, 4-12, 4-17, 4-26, 6-5, 7-9
[F6] 3-8, 3-11, 3-12

[F8] 3-16, 4-9, 5-4, 7-8

Index

[F9] 2-6, 3-7, 3-9, 4-7, 4-15, 7-5, 7-7

[f] 1-11, 3-13

‘[Home] 2-6, 3-15, 3-16

[Ins] 2-6

[ 3-12

[n] 3-8, 4-11

[p] 5-3, 59, 6-5

[q] 2-12

[t] 3-13

[u] 6-4

[yl 3-10, 5-7

[zz] 4-16

[z] 3-8, 4-9, 4-12, 4-27, 5-4
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